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This chapter gives you an overview of the OpenLAB software. It also includes 
certain requirements before starting the installation. 
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1 Introduction
Who Should Read This Guide?
Who Should Read This Guide?

This installation guide is designed to help system administrators and other 
users install the Agilent OpenLAB Chromatography Data System (CDS) to a 
distributed system quickly and correctly.

See your Agilent representative for other system configuration installation 
guides.

Figure 1 Distributed System Configuration
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The Agilent OpenLAB CDS Software
The Agilent OpenLAB CDS Software

The Agilent OpenLAB CDS, along with OpenLAB Electronic Lab Notebook 
(ELN), OpenLAB Enterprise Content Manager (ECM), and OpenLAB Data 
Store plus several add-ons make up the Agilent OpenLAB software suite. 

These integrated solutions form a system designed to grow with customers' 
needs, from a small standalone analytical lab to a global network with 
hundreds of locations. Using the OpenLAB software, instruments from 
multiple vendors can connect to any size network — from individual 
workstations and workgroups to global enterprises. With full instrument 
control, centralized administration and ease-of-support, users can achieve 
lower operational costs and better instrument use. See your Agilent 
representative to learn how other products in the OpenLAB suite can help 
you.

The Agilent OpenLAB CDS software is provided on several edition-specific 
disks. Table 1 lists the disks you will receive for your software edition.

Table 1 OpenLAB CDS Components

Disk Name ChemStation Edition EZChrom Edition

OpenLAB CDS Shared Services Software X X

OpenLAB CDS ChemStation Edition Core 
Software

X

OpenLAB CDS ChemStation Edition Drivers X

OpenLAB CDS EZChrom Edition Core 
Software

X

OpenLAB CDS EZChrom Edition Drivers X

OpenLAB CDS Support X X

OpenLAB CDS Data Store Software X X
CDS Distributed System Installation Guide 7
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Before You Begin

To simplify installation of the software, it is helpful to decide on some 
configuration options before you begin the actual software installation.

1 For installing OpenLAB CDS, you need to have administrator privileges for 
all servers and clients. Power user privileges are not sufficient (the 
installation does not start).

2 Decide on a Shared Services server and a directory location to store all files 
related to the data system software, including data, methods, sequences, 
and configurations.

• CDS clients must be connected via network to the Shared Services 
server.

• If you plan to use the OpenLAB ECM, CDS client users must have 
read/write access to the ECM directory location.

3 If you are installing OpenLAB CDS EZChrom Edition, create an Enterprise 
path folder on the file server, with a share status Everyone > Full permissions. 
Because the system must access this folder as a uniform naming 
convention (UNC) share path, it must be created prior to actual 
installation. UNC paths define the common syntax pattern for share folder 
location and retrieval.

4 For the Shared Services Database server, obtain the:

• Database name

• Database administrator user name and password

• Authentication mode

• Administrator user credentials (domain, user name, password)

5 If you plan to use OpenLAB ECM with your system, obtain the ECM server 
name.

6 In order to install and configure OpenLAB ECM (Shared Services 
configuration on the server) the user must be both ECM administrator as 
well as internal OpenLAB Shared Services administrator.

7 If you plan to use the Oracle DB server, make sure to set up the Oracle DB 
following the description in CDS_oracle11.pdf on Disk1/docs/enu.
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8 Create and define a service account for Agilent Instrument Controller (AIC) 
configuration. You will need to enter this service account information after 
you install the first AIC in your system.

9 Decide on the software delivery approach you want to use:

• Install directly from the DVDs to your computer — Load the disks as 
required directly to the workstation disk drive.

• Copy DVDs to a network share folder for installation — You can use the 
utility to copy DVD content to a network share folder or USB drive, and 
run an uninterrupted installation from that location. This approach will 
save time; when you install from the folder, you won’t have to reload the 
disks.

10 Remember that when you launch the application, you will be able to review 
the following PDFs in the installer Planning and Resources menus before you 
install the software:

Under the Installer Planning menu, you will find:

• Hardware and Software Requirements—Use this PDF to determine 
whether your hardware and software will support the system.

• Distributed System Installation Guide—An electronic copy of this 
installation guide is provided in PDF format for your convenience.

Under the Installer Resources menu, you will find:

• OpenLAB CDS Network Requirements—Use this PDF to check that your 
settings comply with the network requirements.

11 Set up the necessary power, equipment and hardware connections to run 
your system, including any A/D boards, cables, GPIB boards, instrument 
detectors, and communication cables.
CDS Distributed System Installation Guide 9
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Install Windows Server 2008 R2 12

Configure Windows Server 2008 R2 Settings 13

This chapter describes the necessary installation and configuration steps to 
deploy an OpenLAB Shared Services server.
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2 Configuration of Windows Server 2008 R2
Install Windows Server 2008 R2
Install Windows Server 2008 R2

1 Install Windows Server 2008 R2 from recovery DVD or Windows Server 
2008 R2 DVD. During the setup of Windows Server 2008 R2 provide the 
computer name, administrator password and network settings.

2 Select to either join an existing domain or set up the system in workgroup 
mode.

3 To guard your systems against viruses, install an AntiVirus program. 
Running AntiVirus programs might influence the behavior and 
performance of your computer. Agilent OpenLAB CDS was tested to run 
with Symantec's Norton Antivirus.

4 If you plan to use OpenLAB Data Store: 

• Install Microsoft SQL Server 2008 R2 SP1 Standard or Enterprise in 
Mixed Mode on the server. For more information on changing the mode 
for an existing installation, see “Change Server Authentication to Mixed 
Mode” on page 100.

• When installing Microsoft SQL Server 2008 R2, do not select the Reporting 
Services feature. These services use port 80 and will conflict with the 
OpenLAB Data Store web server.

CAUTION Insufficient virus protection

Your PC might get infected.

➔ Keep your computer disconnected from the internet until you have installed the 
appropriate security patches and hot fixes.

➔ It is strongly recommended to install the latest security fixes as supported from 
Agilent Technologies and virus definitions prior to connecting to a network.

NOTE If you plan to use OpenLAB Data Store: Install SP1. You can download the service pack from 
the Microsoft web page (http://support.microsoft.com/kb/976932).

NOTE Do not install or configure any server role or feature.
12 CDS Distributed System Installation Guide
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Configure Windows Server 2008 R2 Settings
Configure Windows Server 2008 R2 Settings

Most changes in the following section are mandatory for A.01.04 to work 
properly on a Windows Server 2008 R2 system. Some changes will optimize 
application performance. Other changes will have a graphical or minor impact.

[MUST] 1 Folder Options (right-click Start > Open Windows Explorer):

a Choose Organize > Layout.

• Enable Menu Bar.

• Enable Navigation Panel.

b Set View to Details.

c Choose Tools > Folder Options > View tab.

• Disable the option Hide extensions for known file types.

• Enable the option Display the full path in the title bar (Classic theme only).

d Apply these settings to all folders by selecting the Apply to Folders button.

[MUST] 2 Go to Start > Control Panel > Windows Update. Check for updates and apply all 
critical security patches.

3 Install additional hotfixes:

• Always install hotfix KB2600907 
(http://support.microsoft.com/kb/2600907).

• If you plan to use OpenLAB Data Store: Install hotfix KB2577795 
(http://support.microsoft.com/kb/2577795).

NOTE To indicate the relative importance of individual settings, each item is categorized as:

• MUST: These changes must be applied.

• PERFORMANCE: These changes will improve system performance.

• OPTIONAL: Most of these changes will affect the graphical display of the application.

NOTE If User Account Control (UAC) is switched on, some configuration steps will require active 
confirmation to continue.
CDS Distributed System Installation Guide 13



2 Configuration of Windows Server 2008 R2
Configure Windows Server 2008 R2 Settings
[MUST] 4 Register Windows Server 2008 R2 with Microsoft.

[MUST] 5 Select Change Settings. Set the Important updates selection to Never check for 
updates. Deselect the other update options.

Close the Update screen.

[MUST] 6 Go to Start > Control Panel > Administrative Tools. Select Services.

a Right click on the Desktop Window Manager Session Manager service. In the 
context menu select Properties.

• Set the startup type to Disabled.

b Right-click on the Application Experience service. In the context menu, 
select Properties.

• Set the startup type to Disabled.

Confirm by clicking OK and close the Services window. Close Administrative 
Tools.

[MUST] 7 Power Options: Start > Control Panel > Change options that are currently 
unavailable > Power Options.

a Enable power plan High performance (Show additional plans).

b Click Change Plan settings.

c Click Change advanced power settings.

• Open the nodes for Hard disk, Turn off hard disk after and check that 
Minutes are set to 0 (=Never).

• Click OK.

d Save the changes.

[MUST] 8 Local Security Policy: (Start > Control Panel > Administrative Tools > Local 
Security Policy)

a Navigate to Security Settings > Local Policies > Security Options.

b Double-click the following policy listed in the right hand panel: Network 
Access: Sharing and security model for local accounts.

c In the displayed dialog select the following item from the drop-down list: 
Classical - local users authenticate as themselves.
14 CDS Distributed System Installation Guide
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[MUST] 9 Region and Language Options (Start > Control Panel > Regional and Language 
Options):

a Regional options should be set to English (United States) from the 
drop-down list.

b If regional format other than English (United States) is used, the following 
settings are mandatory. The settings can be defined by clicking the 
Customize this format button:

• Decimal symbol = . (point)

• Digit grouping symbol = , (comma)

• List separator = , (comma)

c Language for non-Unicode programs:

• On the Administrative tab click Change system locale....

• From the drop-down list, select English (United States).

[MUST] 10 Power Management for network devices (From Start > Control Panel > 
Network and Sharing Center):

a Select Change adapter settings. Click Local Area Connection > Properties > 
Configure).

b On the Power Management tab, uncheck all items.

[MUST] 11 Screen layout (right-click on Start > Control Panel > Display):

a Click on Change color scheme.

b Check that Windows Classic is selected.

[PERFORMANCE] 12 System Properties: Start > Control Panel > System: click Advanced system 
settings.

a On the Advanced tab > Performance hit the Settings button.

• Visual Effects tab, uncheck all entries.

• Advanced tab > Virtual Memory: For optimum performance use the 
Change button to adjust the paging file size to a value of 2 to 3 times of 
the physical RAM on the PC.

• Data Execution Prevention tab: Enable Turn on DEP for essential Windows 
programs and services only.
CDS Distributed System Installation Guide 15



2 Configuration of Windows Server 2008 R2
Configure Windows Server 2008 R2 Settings
b Advanced > Startup and Recovery > Settings button:

• System startup section: Change both Time to display ... fields from 30 to 3 
sec.

c Remote tab

• In the Remote Assistance section, uncheck Allow Remote Assistance 
connections to this computer.

[OPTIONAL] 13 Welcome Center (Start > search for 'gpedit.msc')

• Navigate to Local Computer Policy > Computer Configuration > Administrative 
Templates > System > Logon.

• Enable Don't display the Getting Started welcome screen at logon.

[OPTIONAL] 14 Recycle Bin Properties: (right-click on desktop icon Recycle Bin). Enable 
the following options:

• Custom size; select a size corresponding to approximately 10% of the 
complete disk space for the drive.

• Check Display delete confirmation dialog.

[OPTIONAL] 15 Apply the Security Settings suggested by Microsoft at: 
http://technet.microsoft.com/en-us/library/cc264467.aspx
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 This chapter describes the necessary configuration steps to deploy the 
OpenLAB CDS ChemStation AIC Hardware in a Distributed System.
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Set up an AIC Machine for ChemStation
Set up an AIC Machine for ChemStation

Specifications

Table 2 Hardware Specifications

AIC Model CPU RAM Disk Space

ML150 2.00 GHz 2xQuad Core 8 GB 2x500 GB

NOTE The OpenLAB CDS ChemStation Instrument Controller software uses the Remote Desktop 
Services (RDS) role in Windows Server 2008 R2.

The usage of this role requires, in addition to the Windows Server 2008 Client Access 
License (CAL), a Windows Server 2008 Remote Desktop Services CAL (RDS CAL) to access 
any application or graphical user interface remotely hosted by Windows Server 2008 R2.

You must also have at least one Remote Desktop Services Licensing Server deployed and 
activated in your environment. There is a grace period of 120 days during which no license 
server is required. At the end of the grace period, remote connections will be refused.

For more informations about CAL and RDS CAL requirements, see Windows Server 2008 R2 
Licensing Overview 
(http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=18795).
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Operating System Installation

After booting up the server, a wizard walks you through interview questions to 
prepare the server for operating system installation. Follow the on-screen 
instructions to complete the Operating System installation.

1 Boot up the server.

2 Select English for the language of the operating system, select the keyboard 
type, and click  to proceed with the next step.

3 In the Thank You screen, click  to proceed with the next step.

4 Read and agree with the Microsoft End-User License Agreement, and click 
 to proceed with the next step.

5 Read and agree with the HP End-User License Agreement, click  to 
proceed with the next step.

6 In the OS Partition Screen:

a Select Custom (475903MB)

b Provide an administrator password.

c Confirm the administrator password.

d Click  to proceed with the next step.

NOTE Password policy:

• Cannot be less than 8 characters

• Cannot be more than 63 characters

• Must contain at least 3 of the 4 classes of characters

• Can only contain valid characters:

• a-z

• A-Z

• 0-9

• `~!@#$%^&*()_+={}\:";'<>,./

• Cannot contain username, first name or last name
CDS Distributed System Installation Guide 19
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7 Read and agree with the Microsoft Software License Terms for Microsoft 
Windows Server 2008 R2 Standard.

8 In the operating system contents:

a Review all settings.

b Click  when you are ready to proceed with the installation.

Operating System Configuration

Logon to Microsoft Windows Server 2008 R2 Standard Edition using the 
Administrator account and the password entered in the previous steps.

After you have completed the installation of Windows Server 2008 R2, and 
before you deploy the new server in your enterprise, some configuration is 
required to identify the computer to other computing resources on your 
network, to secure the computer, to enable administrators to perform tasks on 
the computer, and to customize the computer by adding server roles and 
features.

Initial Configuration Tasks for ChemStation AIC

You can finish configuring Windows Server 2008 R2 by performing the 
following three tasks, identified in the Initial Configuration Tasks window that 
is opened when the operating system installation is complete.

• Provide computer information.

• Update this server.

• Customize this server.

NOTE The server will reboot four times during the installation.

NOTE You can run OOBE.EXE to get back to Initial Configuration Tasks after selecting "Do not 
show this window at logon".

NOTE If User Account Control (UAC) is switched on, some configuration steps will require active 
confirmation to continue.
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Provide Computer Information

1 Activate Windows.

2 Set time zone.

3 Configure Networking.

4 Provide computer name and domain (if required).

Update This Server

1 Click on Enable automatic updating and feedback, and select Manually configure 
settings.

2 In Windows automatic updating section:

a Click the change Setting... button.

b Select Never check for updates (not recommended).

3 In Windows Error Reporting:

a Click the change Setting... button.

b Select I don't want to participate, and don't ask me again, or leave the default 
option Ask me about sending a report every time an error occurs.

4 In the Customer Experience Improvement Program section, keep the default 
selection Not participating.

5 Click the Close button when finished.

6 Click Download and install updates.

NOTE Your computer must have an available internet connection to download updates, or to 
configure Windows automatic updating.

NOTE Do not download and install Internet Explorer 9.
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Customize This Server

1 Configure Windows Firewall.

a Click Configure Windows Firewall.

b In the left pane, click Allow a program or feature through Windows Firewall.

c Click Change settings . If you are prompted for an administrator 
password or confirmation, type the password or provide confirmation.

d Under Allowed programs and features, select the check box next to Remote 
Desktop, and then use the check boxes in the columns to select the 
network location types you want to allow communication on.

e Click OK.

2 Click Close on the Initial Configuration Tasks window when finished.

Configure Windows Server 2008 R2 Settings

1 Click  to open Server Manager.

2 Go to Storage > Disk Management and add Disk 1 to the configuration select 
MBR (Master Boot Record).

3 Right-click on CD-ROM 0.

a Select Change Drive Letter and Paths.

b Click the Change button and assign F as drive letter.

c Click Yes in the warning windows.

4 Right click on Disk 1.

a Select New Simple Volume, and click Next.

b Select Max size 476937, and click Next.

c Select D as drive letter, and click Next.

NOTE Adding roles, features and enabling Remote Desktop is not required at this stage. The 
OpenLAB CDS Master Installer will configure these items during the ChemStation 
Instrument Controller installation.

NOTE If the Change settings button is unavailable, you might not have permission to change 
some settings that are managed by your system administrator.
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5 Format the disk with:

• File System: NTFS

• Allocation unit size: Default

• Volume Label: Data (or any other label)

• Select the Perform Quick format check box.

Disable Services

1 In Server Manager, go to Configuration > Services.

2 Stop the Application Experience service, set its startup type to disabled, and 
click OK.

3 Stop the Desktop Window Manager Session Manager service, set its startup 
type to disabled, and click OK.

4 Close Server Manager.

Adjust the Screen for Best Performance

1 Open the Control Panel using Start > Control Panel > System and Security > 
System.

2 Click Advanced system settings.

3 On the Advanced tab in the Performance section, click the Settings button.

4 In the Visual Effects tab, select Adjust for best performance.

Configure the Page File Size

When you set up a 64-bit version of Microsoft Windows Server 2008 and 
Microsoft Windows Server 2008 R2, the operating system will create a page file 
that is auto managed (Automatically manage paging file size for all drives) in 
your computer.

For best performance, do not set the initial size to less than the minimum 
recommended size under Total paging file size for all drives. The recommended 
size is equivalent to 1.5 times the amount of RAM on your system. Usually, you 
should leave the paging file at its recommended size, although you might 
increase its size if you routinely use programs that require a lot of memory.
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1 Select the Advanced tab.

2 In the Virtual memory section, click the Change button.

3 Adjust the page file size, and click OK to save your modifications.

For more information, please read the following article from Microsoft: How to 
determine the appropriate page file size for 64-bit versions of Windows 
Server 2008 or Windows Server 2008 R2 
(http://support.microsoft.com/kb/2021748).

Data Execution Prevention

1 Select the Data Execution Prevention tab.

2 Enable Turn on DEP for essential Windows programs and services only.

3 Click OK to close the performance options.

4 Click OK to close the System Properties window.

Configure the Power Options for the Computer

1 Open the Control Panel using Start > Control Panel > System and Security > 
Power Options.

2 Click Change settings that are currently unavailable.

3 Click High performance.

4 Click Change Plan settings.

5 Click Change advanced power settings.

6 Open the nodes for Hard disk, Turn off hard disk after and check that Minutes 
are set to 0 (=Never).

7 Click OK.

8 Save the changes.

NOTE Changes made for the virtual memory require a restart of the computer before they can take 
effect.
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Disable Power Management on the Network Adapter(s)

1 Open the Control Panel using Start > Control Panel > System and Security > 
System.

2 Click Device Manager.

3 Expand the Network adapters node.

4 Double-click the listed adapter(s), select the Power Management tab, and 
deselect Allow the computer to turn off this device to save power.

5 Click OK and close the Device Manager tool.

6 Restart the computer.

What to do Next

The operating system installation and configuration for the OpenLAB CDS 
ChemStation AIC is now complete. You can now deploy the OpenLAB CDS 
software.
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Prepare an AIC for EZChrom

Make your AIC 5000 CDS Compatible

AIC units are made CDS-compatible before installation of a new OpenLAB 
CDS system. AIC 5000 units require re-imaging of the hard drive files using 
the AIC Software and Utilities DVD, and use of the patching tool to fix 
software deficiencies.

Make sure you have the necessary PC features, hardware, software and 
storage devices to prepare your image controller unit for OpenLAB CDS:

• Windows XP or Windows Vista operating system

• DVD drive

• USB 2.0 port

• the AIC Software and Utilities DVD

• flash drive with minimum 2GB capacity

Preparation: Inspect your Flash Drive

1 Check to see if your flash drive contains any other bootable software.

2 If your flash drive contains other bootable software and you must use it for 
the AIC upgrade, perform a full format and create a FAT32 partition of the 
flash drive.

This will remove any boot partitions from the drive and make it usable for 
the upgrade.

Step 1: Copy the Software to your Flash Drive

1 Insert the flash drive into your PC running the Windows XP or Windows Vista 
operating system.

2 Make note of the drive name—you will need it later.

3 Load the AIC Software and Utilities DVD to your PC disk drive. Autorun will 
launch the software and display the main screen.

4 Select the OpenLAB CDS—EZChrom Edition link.
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5 On the next screen displayed, select the AIC link that corresponds to your 
AIC model number.

6 Select the AIC—Re-Image to Firmware Version 15.0.3 link corresponding to your 
AIC model number.

7 Type y and select enter to confirm that you are making a bootable flash drive 
for the AIC.

8 Enter the drive name for your flash drive.

9 Select enter.

10 If the drive name you entered is correct, confirm by typing y in the field 
provided.

11 Select enter.

The software will format the flash drive, making it bootable, and copy the 
image files to the flash drive.

12 Close any popup windows that may appear during this process— they won’t 
apply to your upgrade.

13 When the copying process is complete, remove your flash drive from the PC. 
Using the safely remove storage device function is recommended.

Step 2: Run the Software on your AIC

1 Turn on the AIC.

2 Press F10 to display the BIOS screen.

3 Verify that USB devices is listed first on the BIOS screen (this means that the 
controller is set to boot from USB devices first).

If it is not, modify the list order so that USB devices is first.

4 If you made changes, select save.

5 Select exit.

6 Turn off the AIC.

7 Insert the flash drive into one of the two USB ports just under the 
keyboard/mouse ports, on the back of the AIC. Do not use the red or blue 
USB ports.

8 Turn on the AIC. The AIC will boot up to the flash drive. The boot process 
takes approximately ten minutes.

9 At the instrument controller Welcome screen, select option C, OpenLAB 
CDS—EZChrom Edition.
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10 Select enter. The system will display a window indicating image transfer 
progress. When the process is complete, you’ll be returned to the previous 
screen.

11 Remove the flash drive from the AIC.

12 Type 
exit in the field provided, and select enter. The AIC will automatically 
reboot.

Step 3: Run the AIC Patching Tool

1 When the AIC has fully booted up after re-imaging, re-insert the flash drive 
into the USB port on the back of the AIC (not one of the red or blue ports). 
Disregard the dialog box that appears after booting up, asking whether the 
AIC will be used for OpenLAB or EZChrom Elite. It will disappear when you 
re-insert the flash drive.

2 If a Systems Settings Change screen appears asking you if you want to restart 
the computer, select No.

3 At the AIC Patching Tool screen, select Apply Patches.

• Note the listing of patches that will be applied to the AIC, including .NET 
3.5 SP1 installation.

• The .NET 3.5 SP1 installation takes approximately ten minutes and runs 
silently. A message will display when all patches have been applied. Do 
not close the AIC Patching Tool screen until you are prompted to do so.

4 When you see the message indicating that all patches have been applied, 
remove the flash drive from the AIC.

5 Close the AIC Patching Tool screen.

6 Reboot the AIC.
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Make your AIC 7800 or 7900 CDS Compatible

AIC units are made CDS-compatible before installation of a new OpenLAB 
CDS system, AIC 7800 and 7900 units are re-imaged using Windows XP SP3 
software. The patching tool is not used, but users must verify that the units 
meet all software requirements for OpenLAB CDS workstations.

Make sure you have the necessary PC features, hardware, software and 
storage devices to prepare your image controller unit for OpenLAB CDS:

• Windows XP SP3 operating system

• Windows software DVDs supplied with unit

• OpenLAB CDS manuals for software requirements and installation 
instructions

Step 1: Understand PC-specific Concerns

The steps below include a hardware drive re-imaging process. Re-imaging 
results in the following:

1 An image file of your hard drive is created, and saved on your hard drive.

2 Current data is removed from your computer. This includes all installed 
programs.

3 Your computer is reset to a ‘newly installed’ condition, with its original 
settings.

Though User files will be saved to a Windows.old folder on the hard drive you 
should, as a precaution, back up your user files before re-imaging. If you 
have any encrypted files, you may not be able to access them after 
re-imaging and reinstallation.

Step 2: Re-image your Hard Drive and Reinstall Windows

1 Using your Windows operating system, go to Start > Control Panel.

2 Type 
recovery in the search box. The Recovery option will appear in the 
window.

3 Select Recovery.

4 Select Advanced recovery methods.
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5 Select Return Windows or your computer to original settings.

Windows will display one of these two manufacturer-set options:

• Return your computer to the factory setting.

• Reinstall Windows.

6 Select the option, and follow the ensuing prompts. Regardless of the option 
provided, at some point you will have to insert the Windows DVD supplied 
to you with your PC, and follow the prompts to reinstall Windows.

Step 3: Verify Prerequisites and Install OpenLAB CDS

1 When reinstallation of Windows is complete, verify the system 
prerequisites for OpenLAB CDS workstations (e.g. .NET SPL, Windows 
Installer, etc.) in the OpenLAB CDS manual.

2 Install OpenLAB CDS using the manual instructions.

Your PC is now compatible with OpenLAB CDS when it is installed to the 
distributed system.

What to do Next

You have now upgraded your AIC for use with the OpenLAB CDS EZChrom 
Edition. You can now install the OpenLAB CDS software.
30 CDS Distributed System Installation Guide



CDS Distributed System Installation Guide
4
Install the Software

Step 1: Run the Application 32

Step 2: Copy DVDs to a Network Share Folder for Installation 
(Optional) 33

Step 3: Run the System Configuration Checker 34

Step 4: Run OpenLAB CDS Installation Wizard on the Shared Services 
Server 36

License Agreement Screen 36
Installation Folder Screen 37
Installation Type Screens for Shared Services Server 38
Installation Type Screens for Data Store Server 41
Summary Screen 42

Step 5: Set up OpenLAB CDS Administration 44

Step 6: Run the OpenLAB CDS Installation Wizard on a CDS Client 46
License Agreement Screen 46
Installation Folder Screen 47
Installation Type Screens 47
Summary Screen 49

Step 7: Run the OpenLAB CDS Installation Wizard on an Instrument 
Controller 51

License Agreement Screen 51
Installation Folder Screen 51
Installation Type Screens 52
Summary Screen 54
EZChrom Only: Identify a Domain Account for Running Instrument 
Services 56

Optional: Install Acrobat Reader 57

What to do Next 58

The installation is automated for you by the included OpenLAB CDS Master 
Installer. This tool installs the various components of OpenLAB CDS.
31Agilent Technologies



4 Install the Software
Step 1: Run the Application
Step 1: Run the Application

To run the application for the first time on a server computer or networked 
workstation:

1 For the direct DVD approach, insert the OpenLAB CDS Installation disk. 
Autorun.inf will automatically run Agilent. OpenLABCDSSetupFromDVD.exe 
and display the installer Planning screen.

2 For the portable data storage device approach, insert the device in a 
computer USB port, navigate to \Disk1\Setup.bat and run the application to 
proceed to the Planning screen.

3 For the share file approach, navigate to the share file folder. Make sure the 
share is mapped to a drive letter; otherwise copy the files to an appropriate 
share on your computer. Then navigate to \Disk1\setup.bat and run the 
application to proceed to the Planning screen.
32 CDS Distributed System Installation Guide



Install the Software 4
Step 2: Copy DVDs to a Network Share Folder for Installation (Optional)
Step 2: Copy DVDs to a Network Share Folder for Installation 
(Optional)

Completing this step will enable you to run an uninterrupted installation 
directly from a folder—i.e., you will not have to load individual disks during 
actual installation.

1 From the Master Installer Planning screen, select Installation from the sidebar 
menu.

2 Select Preparation of an Installation from Network Share.

3 At the Network Share screen, browse to a directory and create a destination 
folder as follows:

a Select the button with the three dots.

b Navigate to the directory where you want to create the folder (you can 
navigate to a USB drive port to create the folder on a USB drive).

c Select Make New Folder.

d Type in the folder name.

e Select OK. The system will return you to the Network Share screen, with 
the path displayed.

f Select the disks you want to copy to the folder: All disks, ChemStation disks, 
or EZChrom disks.

g Select Start.

h Follow the prompts to insert new disks as they appear.

4 When processing is complete, copy the files to the local drive or map the 
location to a network drive.

5 Close the application and navigate to the directory and folder you created. 
Open the folder.

6 Select the Disk 1 folder, then execute Setup.bat to run the application.

The system will display the installer Planning screen.

NOTE Installations into the root of a drive may cause problems during operations and are not 
supported.
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Step 3: Run the System Configuration Checker

1 At the Planning screen, select System Configuration Checker.

2 For the server configuration check, select OpenLAB CDS Shared Server Core 
A.01.XX from the drop-down list.

3 If you want to install OpenLAB Data Store: Select OpenLAB Data Store Server 
(All-In-One) A.01.01 to check the server.

4 If you want to install ChemStation Edition: 

• Select OpenLAB CDS ChemStation Edition (CDS client) to check a CDS client.

• Select OpenLAB CDS ChemStation Edition (Instrument Controller) to check an 
AIC.

5 If you want to install EZChrom Edition: Select OpenLAB CDS EZChrom Edition 
A.04.XX to check a CDS client or AIC.

6 Select OK.

7 Complete page 1 of the Contact Information—System details by typing in the 
fields provided.

• System Location fields

• System Information fields

• Configuration fields

8 Review the system details and make any necessary entries. The system will 
follow the paths specified.

9 Select the green check-mark icon in the top left corner of the screen to 
begin the software check. A summary report is displayed showing the 
results for each check category. Results are expressed as Pass, Warning, 
Critical Warning, or Fail. 

Fail results must be corrected before continuing with the installation. 
Agilent recommends investigating and correcting any Critical Warnings and 
Warnings whenever possible before proceeding.

NOTE The regional settings must be configured to use the dot ('.') as a decimal separator.
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10 To view details of the report, select the appropriate link: System Hardware 
Details, Operating System and Software Details, or Manual Verification Required.

11 To save the report, select the Save icon at the top left of the screen.

12 E-mail the saved report to your Agilent Service Representative for 
evaluation, and for validation of your personal computer for Agilent 
Software Systems Installs.
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Step 4: Run OpenLAB CDS Installation Wizard on the Shared 
Services Server

At this point, you will be installing to the Shared Services server either 
directly from the DVDs or from a local drive (mapped to either USB/eSATA 
drive or a network location). The installation steps are identical until you start 
the installation wizard: you won’t be prompted to load the DVDs if you are 
installing from a centralized location.

License Agreement Screen

1 If you will be using a local database for the server, you must have Windows 
Installer 4.5 installed. To install it from the Installation screen:

a Select Third Party Tools and then Windows Installer 4.5.

b Read the licensing agreement.

c Select Accept to accept the agreement and begin Windows Installer 4.5 
installation.

d When installation is complete, click OK to return to the Installation screen.

2 Select OpenLAB CDS.

3 If your Shared Services server is running under Windows 2003 Server R2 
and if .NET 3.5 SP1 is not on your system, the Agilent OpenLAB CDS 
Prerequisites Setup screen appears.

a Read the licensing agreement.

b Select Accept to accept the agreement and begin .NET 3.5 SP1 
installation.

NOTE If you select Don't Accept at this screen, the install program will exit. You will have to 
install .NET 3.5 SP1 or higher at a later time to proceed with OpenLAB CDS installation.
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If your Shared Services server is running under Windows 2008 Server R2, 
.NET 3.5 SP1 will be installed automatically.

4 The OpenLAB CDS Installation Wizard opens. Read the terms of the License 
Agreement. Master Installer provides a printable PDF of the license 
agreement under the Resources option of the main menu.

5 Select I agree with the terms and conditions. You cannot proceed with 
installation unless you agree to these terms.

6 Select Next to proceed to the Installation Folder screen.

Installation Folder Screen

1 Type the folder name or browse to the folder where you want to store the 
application components.

2 To run an installation qualification as part of this Shared Services server 
installation, select Run Installation Qualification.

Because there can be several separate installation procedures for a 
distributed system, you may prefer to run the IQ during the last 
installation, or sometime after your system is completely installed (see 
“Optional Procedures” on page 75 in this manual).

3 Select Next to proceed to the Installation type screen.

NOTE Installations into the root of a drive may cause problems during operation and are not 
supported.

NOTE The installation folder of ChemStation on the AIC must not be shared. Doing so will disable 
launching the instrument from the CDS client.
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Installation Type Screens for Shared Services Server

Follow this procedure to install the OpenLAB Shared Services server without 
Data Store. To install the Data Store server, skip this step and continue with 
“Installation Type Screens for Data Store Server” on page 41.

1 Under the Installation type screen, select Networked System.

2 Select Next to proceed to the Networked system screen.

3 Select Shared Services Server.

4 Select Next.

5 Complete the Database type screen by selecting either New SQL Server 
installation, Existing SQL Server or Existing Oracle Server.

The New SQL Server installation option requires Windows Installer 4.5, as 
described in the License Agreement Screen steps above.

6 Configure the database as described in the following steps.

7 If you selected New SQL Server installation:

a Type the path or browse to the directory where you want to store the 
application components. Directory names must be entered without 
spaces.

b Select Next.

c Complete the Database name field.

d Select the authentication mode.

e Select Next to proceed to the Additional items, Language, and Register 
applications screens.

8 If you selected Existing SQL Server:

a Type the database server name in the field provided.

b Select Use default instance or Use named instance.

If you select Use named instance, complete the Database instance name field.

c Select Next.

NOTE If you select the Use SQL server authentication mode, complete the DB user name, DB 
user password, Administrator name, and Administrator password fields.
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d Complete the Server connection type screen. Select either Create new 
database or Connect to existing database. If you select Connect to existing 
database:

• Enter the Database name in the field provided.

• Select the authentication mode. If you select the  Use SQL server 
authentication mode, complete the DB user name, DB user password, 
Administrator name, and Administrator password fields.

• Click Test Connection... to run a connectivity check. The system will 
verify that the connection from this machine to the SQL server is 
functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

e Select Next. If you entered Connect to existing database in the previous step, 
the system will proceed to the Additional items screen. If you selected 
Create New Database in the previous step, the system will display an 
OpenLAB Shared Services database screen.

• Enter the Database name in the field provided.

• Select the authentication mode. If you select the Use SQL server 
authentication mode, complete the DB user name, Database user password, 
Administrator name, and Administrator password fields.

• Select Next to proceed to the Additional items screen.

9 If you selected Existing Oracle Server:

a Enter the Database server name in the field provided.

b Select Next.

c In the Server connection type screen, select the Initialize data check box if 
you want to write configuration data, like standard permissions and 
roles, into the database.

d Enter the Database name and the Database user name in the field provided.

The database user name is the administrator name that was defined 
during the Oracle Server installation.

e Enter the Database administrator password.

f Check the Listener port number. By default, it is set to 1521.

g Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the Oracle server is 
functioning.
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The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

10 If you want to use OpenLAB ECM with your data system:

a Check the ECM Server option button. The system will activate a Server 
name field.

b Enter the server name without spaces.

c Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the ECM server is functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

11 Under OpenLAB Shared Services Language, select the correct language from 
the drop-down list.

12 Under Register applications, check the edition that applies. If you check the 
EZChrom Edition, the system will activate an Enterprise path field. This is the 
UNC path you created in the Before you Begin steps. Type in the path 
name, or browse to the directory. Path names must be entered without any 
spaces.

13 Select Next to proceed to the Summary screen.
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Installation Type Screens for Data Store Server

1 Under the Installation type screen, select Networked System.

2 Select Next to proceed to the Networked system screen.

3 Select Data Store Server.

4 Select Next to proceed to the Database type screen.

5 Type the database server name in the field provided.

6 Select Use default instance or Use named instance.

If you select Use named instance, complete the Database instance name field.

7 Select Next.

8 Complete the Server connection type screen. Select either Create new database 
or Connect to existing database. If you select Connect to existing database:

a Enter the Database name in the field provided.

b Select the authentication mode. If you select the  Use SQL server 
authentication mode, complete the DB user name, DB user password, 
Administrator name, and Administrator password fields.

c Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the SQL server is functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

9 Select Next.

10 If you entered Connect to existing database in the previous step, the system 
will proceed to the Additional items screen. If you selected Create New 
Database in the previous step, the system will display an OpenLAB Shared 
Services database screen.

a Enter the Database name in the field provided.

b Select the authentication mode. If you select the Use SQL server 
authentication mode, complete the DB user name, DB user password, and 
Administrator password fields.

11 Select Next to proceed to the Additional items screen.

Preparations • Microsoft SQL Server 2008 R2 Standard or Enterprise must be installed in Mixed Mode on the 
server.

• Port 80 must be open for OpenLAB Data Store to function correctly.
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12 In the Content files directory field, enter a suitable location to upload all data 
from OpenLAB CDS applications.

This location will hold the content files for OpenLAB Data Store. Therefore, 
the location must be on a disk that has plenty of storage space.

13 Under OpenLAB Shared Services Language, select the correct language from 
the drop-down list.

14 Under Register applications, check the edition that applies. If you check the 
EZChrom Edition, the system will activate an Enterprise path field. This is the 
UNC path you created in the Before you Begin steps. Type in the path 
name, or browse to the directory. Path names must be entered without any 
spaces.

15 Select Next to proceed to the Summary screen.

Summary Screen

1 Review the installation settings that you have selected in the preceding 
steps. Select Back as necessary to change installation settings, or Cancel to 
cancel the installation.

2 Select Start to begin installation.

The system performs an automated system check before it proceeds with 
the listed activities.

If a system check passed message appears, installation continues.

If a system check failed message appears, you can either:

• Decline to view the system report, and continue installation.

• View the system report, and decide to continue installation.

NOTE Before starting or canceling the installation, you can save an XML file with your installation 
settings. This XML can then be used for a scripted installation (see “About Scripted 
Installation” on page 66).
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• View the system report and postpone installation until the problem is 
fixed.

• Decline to view the system report and postpone.

3 Your installation settings determine which disks need to be copied during 
installation. If you are installing directly from the DVDs, follow the Insert 
Disk prompts as they appear.

If you are installing from a local drive, you won't insert disks or browse to 
disk folders — the entire installation will run automatically, based on your 
installation settings.

If the OpenLAB CDS Installation Wizard cannot locate a necessary file 
(whether on a disk or in a folder), a Disk or File not found prompt will appear.

For disks, follow the prompts to:

• Retry using the same disk.

• Insert the correct disk (if you made an error), and select OK.

• Select Cancel to cancel the installation. The system will uninstall any 
components installed so far.

If a file in a centralized folder cannot be found, you may have to recreate the 
folder. See “Step 2: Copy DVDs to a Network Share Folder for Installation 
(Optional)” on page 33.

If the installation of any vital application or component fails, the 
installation will roll back (uninstall). If a failed component can be installed 
at a later time without affecting basic installation (e.g. ECM API, Driver) the 
installation will proceed. In this case, you will be notified of any failure, and 
that further steps are necessary to fully complete installation.

4 If an IQ was completed as part of this installation, review the Installation 
Qualification Report. If the report indicates failure, verify the computer 
requirements and reinstall the data system. Do not use the system until an 
Installation Qualification Report gives a ‘pass’ result.

5 Click Finish to close the installation wizard.

6 Reboot the server after the installation.

NOTE To view the system report as PDF file, Adobe Reader must be installed.
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Step 5: Set up OpenLAB CDS Administration

1 From the Shared Services server, open OpenLAB CDS from the OpenLAB 
CDS Control Panel shortcut on the desktop or go to Start > All Programs > 
Agilent Technologies > OpenLAB > OpenLAB Control Panel.

2 From the navigation pane, select Administration > System Configuration.

3 In the System Configuration toolbar, select Edit System Settings.

4 In the Edit System Settings window, select your authentication provider from 
the drop-down list.

If you installed a Data Store server, you can only choose between Internal, 
Windows Local, or Windows Domain.

5 Select your storage provider from the drop-down list.

The storage type Data Store is available only if Data Store has been deployed.

6 Select Next.

7 Select a user to administrate the system.

a If you selected Internal as an authentication provider:

• Select Create Account.

• In the Create Administrator Account dialog box, enter a Name and a 
Password.

b If you selected Windows Local as an authentication provider:

• Select Select Account.

• Enter a search string.

• In the Search Users dialog box, select Search to view a list of users.

• Select a user.

c If you selected Windows Domain as an authentication provider:

• Select the check box to activate the input fields.

• Enter a Domain, User, and Password.

• Select Select Account.

• Enter a search string.
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• In the Search Users dialog box, select Search to view a list of users.

• Select a user.

d If you selected ECM as an authentication provider:

• Provide the ECM Server URL and enter the ECM user credentials.

• Select Select Account.

• Enter a search string.

• In the Search Users dialog box, select Search to view a list of users.

• Select a user.

8 Select OK.

9 If you selected Data Store as the storage provider: Activate Data Store.

a Enter the URL of the Data Store server (http://<server name>).

b Enter the credentials required for activation.

c Click Activate.

A success message is shown. Click OK to confirm.

If activation fails:

• Verify URL and credentials.

• Restart the AlfrescoTomcat service.

• Check the firewall.

• Check for port conflicts. Port 80 must be open.

10 Select Next.

11 Review your settings and select Apply.
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Step 6: Run the OpenLAB CDS Installation Wizard on a CDS Client

Use these procedures to install the software to any number of CDS clients 
connected to the Shared Services server.

Other than EZChrom, ChemStation is not installed directly on the CDS client 
but on the AIC. You can access the ChemStation instance on the AIC machine 
from any ChemStation CDS client via a Remote Desktop Services connection.

Here again you will be running your installation(s) either using the DVDs 
directly, or from a centralized folder. The installation steps are identical until 
you start the installation wizard: you won’t be prompted to load the DVDs if 
you are installing from a centralized location.

License Agreement Screen

1 From the OpenLAB CDS Master Installer screen, select Installation.

2 Select OpenLAB CDS.

3 If .NET 3.5 SP1 is not on your system, the Agilent OpenLAB CDS Prerequisites 
Setup Screen appears.

a Read the licensing agreement.

b Select Accept to accept the agreement and begin .NET 3.5 SP1 
installation.

4 The OpenLAB CDS Installation Wizard opens. Read the terms of the License 
Agreement. Master Installer provides a printable PDF of the license 
agreement under the Resources option of the main menu.

5 Select I agree with the terms and conditions. You cannot proceed with 
installation unless you agree to these terms.

6 Select Next to proceed to the Installation Folder screen.

NOTE If you select Don't Accept at this screen, the install program will exit. You will have to 
install .NET 3.5 SP1 or higher at a later time to proceed with OpenLAB CDS installation.
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Installation Folder Screen

1 Type the folder name or browse to the directory where you want to store 
the application components.

2 To run an installation qualification as part of this CDS client installation, 
select Run Installation Qualification.

Because there can be several separate installation procedures for a 
distributed system, you may prefer to run the IQ during the last 
installation, or sometime after your system is completely installed (see 
“Optional Procedures” on page 75 in this manual).

3 Select Next to proceed to the Installation type screen.

Installation Type Screens

1 Under the Installation type screen, select Networked System.

2 Select Next to proceed to the Networked system screen.

3 Select CDS client.

4 Select Next.

5 Under CDS Edition select the OpenLAB CDS edition you want to install:

• ChemStation or

• EZChrom

6 Select Next.

7 If you chose the ChemStation edition:

a In the OpenLAB Shared Services Settings for Registration screen complete the 
Server name field.

b Choose the authentication service provider which you configured on the 
OpenLAB Shared Services server.

c Provide the corresponding user credentials (see “Step 5: Set up 
OpenLAB CDS Administration” on page 44).

d When you type in the Server name, the Test Connection... button will be 
activated. You can test connectivity for this server before completing the 
rest of this screen.

e Continue with step 9.
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8 If you chose the OpenLAB EZChrom Edition:

a Under OpenLAB CDS EZChrom Edition, select the Install print server check box 
if you want to install the OpenLAB CDS print server.

b Select Next.

c In the OpenLAB Shared Services Settings for Registration screen complete the 
Server name field.

d Choose the authentication service provider which you configured on the 
OpenLAB Shared Services server.

e When you type in the Server name, the Test Connection... button will be 
activated. You can test connectivity for this server before completing the 
rest of this screen.

9 Select Next. The system will perform a connectivity check for the server.

If the connectivity test fails, verify that the server name was entered 
correctly, without spaces, and select Next to run the test again. If the test is 
still unsuccessful, you can:

• Enter a new server and try another test.

• Call internal support for assistance if you cannot connect to a server.

When a connectivity test has run successfully, the system will proceed to 
the Additional items screen.

10 Choose the required Data Storage Location. 

11 If you want to use OpenLAB ECM with your data system:

a Check the ECM Server option button. The system will activate a Server 
name field.

b Enter the server name without spaces.

c Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the ECM server is functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

12 Select Next to proceed to the Summary screen.
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Summary Screen

1 Review the installation settings that you have selected in the preceding 
steps. Select Back as necessary to change installation settings, or Cancel to 
cancel the installation.

2 Select Start to begin installation.

The system performs an automated system check before it proceeds with 
the listed activities.

If a system check passed message appears, installation continues.

If a system check failed message appears, you can either:

• Decline to view the system report, and continue installation.

• View the system report, and decide to continue installation.

• View the system report and postpone installation until the problem is 
fixed.

• Decline to view the system report and postpone.

3 Your installation settings determine which disks need to be copied during 
installation. If you are installing directly from the DVDs, follow the Insert 
Disk prompts as they appear.

If you are installing from a local drive, you won't insert disks or browse to 
disk folders — the entire installation will run automatically, based on your 
installation settings.

If the OpenLAB CDS Installation Wizard cannot locate a necessary file 
(whether on a disk or in a folder), a Disk or File not found prompt will appear.

NOTE Before starting or canceling the installation, you can save an XML file with your installation 
settings. This XML can then be used for a scripted installation (see “About Scripted 
Installation” on page 66).

NOTE To view the system report as PDF file, Adobe Reader must be installed.
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For disks, follow the prompts to:

• Retry using the same disk.

• Insert the correct disk (if you made an error), and select OK.

• Select Cancel to cancel the installation. The system will uninstall any 
components installed so far.

If a file in a centralized folder cannot be found, you may have to recreate the 
folder. See “Step 2: Copy DVDs to a Network Share Folder for Installation 
(Optional)” on page 33.

If the installation of any vital application or component fails, the 
installation will roll back (uninstall). If a failed component can be installed 
at a later time without affecting basic installation (e.g. ECM API, Driver) the 
installation will proceed. In this case, you will be notified of any failure, and 
that further steps are necessary to fully complete installation.

4 If an IQ was completed as part of this installation, review the Installation 
Qualification Report. If the report indicates failure, verify the computer 
requirements and reinstall the data system. Do not use the system until an 
Installation Qualification Report gives a ‘pass’ result.

5 Click Finish to close the installation wizard.
50 CDS Distributed System Installation Guide



Install the Software 4
Step 7: Run the OpenLAB CDS Installation Wizard on an Instrument Controller
Step 7: Run the OpenLAB CDS Installation Wizard on an 
Instrument Controller

License Agreement Screen

1 From the OpenLAB CDS Master Installer screen, select Installation.

2 At the Installation screen, select OpenLAB CDS Installation.

3 The OpenLAB CDS Installation Wizard opens. Read the terms of the License 
Agreement. Master Installer provides a printable PDF of the license 
agreement under the Resources option of the main menu.

4 Select I agree with the terms and conditions. You cannot proceed with 
installation unless you agree to these terms.

5 Select Next to proceed to the Installation Folder screen.

Installation Folder Screen

1 Type the folder name or browse to the directory where you want to store 
the application components.

2 To run an installation qualification as part of this Instrument Controller 
installation, select Run installation qualification.

Because there can be several separate installation procedures for a 
distributed system, you may prefer to run the IQ during the last 
installation, or sometime after your system is completely installed (see 
“Optional Procedures” on page 75 in this manual).

3 Select Next to proceed to the Installation type screen.
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Installation Type Screens

1 Under the Installation type screen, select Networked System.

2 Select Next.

3 Select Instrument Controller.

4 Select Next.

5 Under CDS Edition select the OpenLAB CDS edition you want to install:

• ChemStation or

• EZChrom

6 Select Next.

7 If you choose the ChemStation edition:

a Complete the configuration options screen.

b Under Installation folder, type the path or browse to the directory where 
you want to store the application components. Directory names must be 
entered without spaces.

c Under Instrument accounts you can choose to select the Use customized 
instrument accounts check box.

If you clear the check box, the system will use default instrument 
accounts.

If you select the check box, type the path in the Accounts file field, or 
browse to the directory where your customized instrument accounts are 
stored. Directory names must be entered without spaces.

d Select Next to proceed to the OpenLAB Shared Services Settings screen.

e Complete the Server Name, Domain, OLSS Server Username, and OLSS Server 
Password by typing in the fields provided. Server names must be entered 
without spaces.

f When you type in the Server Name, the Test Connectivity button will appear. 
You can test connectivity for this server before completing the rest of this 
screen.

CAUTION Installation folder must not be shared.

➔ The installation folder of ChemStation on the AIC must not be shared. Doing so will 
disable launching the instrument from the CDS client.
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8 If you choose the EZChrom edition:

a The Install printer server check box in the OpenLAB CDS EZChrom screen is 
deactivated, because the print server installation is not supported for 
AICs.

b Select Next to proceed to the OpenLAB Shared Services Settings screen.

c Complete the Server Name, Domain, OLSS Server Username, and OLSS Server 
Password by typing in the fields provided. Server names must be entered 
without spaces.

d When you type in the Server Name, the Test Connectivity button will appear. 
You can test connectivity for this server before completing the rest of this 
screen.

9 If you want to use OpenLAB ECM with your data system:

a Check the ECM Server option button. The system will activate a Server 
name field.

b Enter the server name without spaces.

c Click Test Connection... to run a connectivity check. The system will verify 
that the connection from this machine to the ECM server is functioning.

The system will display a Connection succeeded message if the check is 
successful. Click OK to close the message.

10 Select Next. The system will perform a connectivity check for the server.

If the connectivity test fails, verify that the server name was entered 
correctly, without spaces, and select Next to run the test again. If the test is 
still unsuccessful, you can:

• Enter a new server and try another test.

• Call internal support for assistance if you cannot connect to a server.

When a connectivity test has run successfully, the system will proceed to 
the Additional items screen.
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Summary Screen

1 Review the installation settings that you have selected in the preceding 
steps. Select Back as necessary to change installation settings, or Cancel to 
cancel the installation.

2 Select Start to begin installation.

The system performs an automated system check before it proceeds with 
the listed activities.

If a system check passed message appears, installation continues.

If a system check failed message appears, you can either:

• Decline to view the system report, and continue installation.

• View the system report, and decide to continue installation.

• View the system report and postpone installation until the problem is 
fixed.

• Decline to view the system report and postpone.

3 Your installation settings determine which disks need to be copied during 
installation. If you are installing directly from the DVDs, follow the Insert 
Disk prompts as they appear.

If you are installing from a local drive, you won't insert disks or browse to 
disk folders — the entire installation will run automatically, based on your 
installation settings.

If the OpenLAB CDS Installation Wizard cannot locate a necessary file 
(whether on a disk or in a folder), a Disk or File not found prompt will appear.

NOTE Before starting or canceling the installation, you can save an XML file with your installation 
settings. This XML can then be used for a scripted installation (see “About Scripted 
Installation” on page 66).

NOTE To view the system report as PDF file, Adobe Reader must be installed.
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For disks, follow the prompts to:

• Retry using the same disk.

• Insert the correct disk (if you made an error), and select OK.

• Select Cancel to cancel the installation. The system will uninstall any 
components installed so far.

If a file in a centralized folder cannot be found, you may have to recreate the 
folder. See “Step 2: Copy DVDs to a Network Share Folder for Installation 
(Optional)” on page 33.

If the installation of any vital application or component fails, the 
installation will roll back (uninstall). If a failed component can be installed 
at a later time without affecting basic installation (e.g. ECM API, Driver) the 
installation will proceed. In this case, you will be notified of any failure, and 
that further steps are necessary to fully complete installation.

4 If an IQ was completed as part of this installation, review the Installation 
Qualification Report. If the report indicates failure, verify the computer 
requirements and reinstall the data system. Do not use the system until an 
Installation Qualification Report gives a ‘pass’ result.

5 Click Finish to close the installation wizard.

NOTE The installation of a ChemStation AIC requires a reboot. It is very important that the 
installing user logs on again to the AIC after the reboot. Otherwise the CDS clients cannot 
configure or launch any ChemStation instrument on this machine.
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EZChrom Only: Identify a Domain Account for Running Instrument 
Services

-first AIC installation only-

This essential step must be completed for EZChrom edition after you have 
installed your first instrument controller using the procedures above.

1 Go to Start > Programs > Agilent Technologies > OpenLAB CDS EZChrom Edition > 
AIC and Driver Install Tool.

2 At the OLSS EZChrom Tool —Login screen, type your User Name, Password, and 
Domain in the fields provided.

3 Select Login.

4 At the OpenLAB Shared Services EZChrom Registrations Functions screen, select 
the Instrument Service Account tab.

5 Type the Service Account Credentials in the fields provided:

• User name

• Password

• Domain

The user specified for this service account must be set as a local 
administrator on all AICs.

6 Select Store.

7 Close the tool.

From this point forward you can install the software to any number of 
additional instrument controllers linked to the network server and 
instruments, omitting this step—the system will retrieve the domain account 
information automatically.
56 CDS Distributed System Installation Guide



Install the Software 4
Optional: Install Acrobat Reader
Optional: Install Acrobat Reader

In order to view site prep or administrative reports (such as system reports), 
or to use the new Report Viewer Feature (ChemStation Edition only) you need 
a PDF reader.

If a PDF reader is not installed on your system, you can install Adobe Reader 
version 10.1.0 from the OpenLAB CDS installation DVDs. It is available on 
disk6/Adobe Reader in 4 language versions (English, Japanese, Chinese and 
Portuguese).

Run the self-extracting exe-file of your choice and follow the instructions of 
the Adobe Reader X Setup wizard.
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What to do Next

The basic installation of the data system software is complete.

There is a 60-day Startup License for this system, and the expiration period 
starts with your first launch of an application.

To request and download your final software license, and add the license file 
to your system, see the Software License Installation Guide.

After you have acquired and installed your final software license, you will 
continue to prepare your data system for operation by end users by 
configuring projects, users, and instruments. This is accomplished through the 
OpenLAB CDS Control Panel, which features an online help resource. For 
more information, please contact your Agilent representative.
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About Uninstallation

Like the installation, the uninstallation of OpenLAB CDS is automated by the 
OpenLAB CDS Master Installer. 

For your convenience, Master Installer uses the same user interfaces for the 
software uninstallation of all OpenLAB CDS configurations (standalone or 
networked workstation). The OpenLAB CDS Uninstallation Wizard under the 
Maintenance section of the Master Installer guides you through the 
uninstallation steps.

For uninstalling OpenLAB CDS, you need to have administrator privileges for 
all servers and clients. Power user privileges are not sufficient (the 
uninstallation does not start).
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Step 1: Run the Master Installer

To run the Master Installer on your workstation choose one of the following 
approaches:

• To run the uninstallation from disk, insert the OpenLAB CDS Installation 
disk (Disk 1).

Autostart will automatically run Agilent.OpenLABCDSSetupFromDVD.exe 
and display the installer Planning screen.

• For the portable data storage device  approach, insert the device in a 
computer USB port, navigate to \Disk1 and run Setup.bat to proceed to the 
Planning screen.

• For the share file  approach, copy the contents to the local drive and 
navigate to the respective share file folder. Then navigate to \Disk1 and run 
Setup.bat to proceed to the Planning screen.
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Step 2: Run the OpenLAB CDS Uninstallation Wizard on a CDS 
Client

1 From the Master Installer Planning screen, select Maintenance from the side 
bar menu.

2 Select OpenLAB CDS Uninstallation.

The OpenLAB CDS Uninstallation Wizard opens.

3 In the Shared Components screen: 

a Check the Uninstall Installation Qualification check box.

b If you want to remove IO Libraries as well, select the Uninstall IO Library 
check box.

4 Select Next to proceed to the Summary screen.

5 In the Summary screen under Uninstallation of OpenLAB CDS Components, there 
is a list of the components you want to uninstall.

6 Select Start to start the uninstallation.

7 If you want to abort the uninstallation, select Cancel. If you want to change 
any settings, select Back.

All listed components are automatically uninstalled, one after another.

When a component is uninstalled correctly, the status shown in the Status 
field of the Maintenance screen changes from Installed to Uninstalled 
successfully.

When the uninstallation has finished, click Finish to close the Uninstallation 
Wizard.

NOTE IQ needs to be uninstalled if you want to reinstall OpenLAB CDS at a later time.
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Step 3: Run the OpenLAB CDS Uninstallation Wizard on an 
Instrument Controller

1 From the Master Installer Planning screen, select Maintenance from the side 
bar menu.

2 Select OpenLAB CDS Uninstallation.

The OpenLAB CDS Uninstallation Wizard opens.

3 In the Shared Components screen: 

a Check the Uninstall Installation Qualification check box.

b If you want to remove IO Libraries as well, select the Uninstall IO Library 
check box.

4 Select Next to proceed to the Summary screen.

5 In the Summary screen under Uninstallation of OpenLAB CDS Components, there 
is a list of the components you want to uninstall.

6 Select Start to start the uninstallation.

7 If you want to abort the uninstallation, select Cancel. If you want to change 
any settings, select Back.

All listed components are automatically uninstalled, one after another.

When a component is uninstalled correctly, the status shown in the Status 
field of the Maintenance screen changes from Installed to Uninstalled 
successfully.

When the uninstallation has finished, click Finish to close the Uninstallation 
Wizard.

NOTE IQ needs to be uninstalled if you want to reinstall OpenLAB CDS at a later time.
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Step 4: Run the OpenLAB CDS Uninstallation Wizard on the 
OpenLAB Shared Services Server

1 From the Master Installer Planning screen, select Maintenance from the side 
bar menu.

2 Select OpenLAB CDS Uninstallation.

The OpenLAB CDS Uninstallation Wizard opens.

3 In the Shared Components screen, check Uninstall Installation Qualification and 
Uninstall MS SQL Server 2008 R2.

Under SQL Instance, select the instance you want to uninstall from the 
drop-down list.

4 Select Next to proceed to the Summary screen.

5 In the Summary screen under Uninstallation of OpenLAB CDS Components, there 
is a list of the components you want to uninstall.

6 Select Start to start the uninstallation.

7 If you want to abort the uninstallation, select Cancel. If you want to change 
any settings, select Back.

All listed components are automatically uninstalled, one after another.

When a component is uninstalled correctly, the status shown in the Status 
field of the Maintenance screen changes from Installed to Uninstalled 
successfully.

When the uninstallation has finished, click Finish to close the Uninstallation 
Wizard.

NOTE IQ needs to be uninstalled if you want to reinstall OpenLAB CDS at a later time.
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This chapter describes the syntax and parameters for an installation or 
uninstallation in command line mode.
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About Scripted Installation
About Scripted Installation

The OpenLAB CDS Master Installer supports a command line mode for 
installation, the so-called scripted installation. This mode supports 
installation, upgrade, repair, and uninstallation. You can execute scripted 
installations either manually or as part of software management systems such 
as LANDesk or HP CM. With the corresponding parameter (-q), the scripted 
installation is completely UI-less.
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Export as XML 

The Master Installer supports a feature to export the installation parameters 
into an XML file which you can then use for the scripted installation.

This feature is also supported for upgrade and repair. However, for these cases 
the exported installation XML file is not appropriate. For scripted repair and 
upgrade, you must prepare specific XML files using the respective Master 
Installer wizards.

1 Launch the OpenLab CDS Installation Wizard.

2 Follow the instructions as described under Install the Software in this 
manual.

3 When you have reached the Summary screen, click the icon  on the top 
right corner to export the installation parameters to XML. Save the file on a 
physical drive.

You can now use the XML file for the scripted installation.

NOTE Installation file and XML file must not be in the same file path.
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Parameters

You can call Agilent.OpenLAB.CDSInstaller.exe in command line mode with the 
following parameters:

• -i

Installation, upgrade or repair

• -u

Uninstallation

• ConfigurationXML="<ConfigurationXMLFilePath>"

The XML file contains all required inputs of the Master Installer to install, 
upgrade, or repair a certain topology (see “Export as XML” on page 67). 
Replace <ConfigurationXMLFilePath> with the correct file path and XML 
file name.

• KeepComponents

Optional parameter for the uninstallation process, which can contain one 
or more shared components that should stay on your system. Without this 
parameter, all OpenLAB CDS components will be removed from your 
system. To keep certain shared components, list the corresponding IDs 
from the table below in double quotes and separated by comma.

• -q

Silent mode — no installation or uninstallation wizard will be shown.

NOTE Do not enter a blank before or after the equals (=) sign. The scripted installation and 
uninstallation mode will not work as expected.

Component Name Id

Installation Qualification IQT

Microsoft SQL Server SQLServer

IO Library IOLibraries
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Return Codes

After installation in the command line mode, the system will return a number 
code which is explained below.

Table 3 Return codes for installation, upgrade, or repair

Error/Return Code Return value

Unknown (default) -1

Success 0

CoreComponentFailure 1

NonCoreComponentFailure 2

TestConnectivityFailure 3

ExpectedWindowsInstallerNotInstalled (WI 4.5 missing) 4

ParameterMismatchError 5

CannotProceedWithFreshInstallation 6

CannotProceedWithUpgrade 7

CannotProceedWithRepair 9

CannotProceedWithReRegistration 10

ReRegistrationNotSupported 11

IncompleteTopologyFound 12

InvalidUNCPath 13

MissingInstallable 14

NotAStrongPassword 15

DowngradeNotSupported 16

RestartRequired 17

InvalidInputXML 19

InvalidMode 20

SitePrepFailure 21
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Table 4 Return codes for uninstallation

Error/Return Code Return value

Unknown (default) -1

Success 0

CannotProceedWithUninstallation 8

RegistryCleanupError 18
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Installation, Upgrade, or Repair

In installation mode, the OpenLAB CDS Master Installer checks if .Net 
Framework is present on your system. If not, it will automatically be installed. 
Select Accept to agree with the license agreement.

The Master Installer evaluates the products already installed on your system. 
Depending on the installed components, the Master Installer will offer one of 
the following options:

• Start a fresh installation

• Upgrade

• Repair

If a required installable is missing, the Master Installer will create an entry in 
a log file, and, depending on the component type, will continue or rollback the 
installation. A corresponding error code will be returned in such scenarios.

1 Right-click the executable of the command prompt or Power shell prompt, 
and run it as administrator.

You will get a return code for the scripted installation only if you start it as 
administrator.

2 Navigate to the drive where you have saved the disks.

For example: C:\CDS_DVD

3 To start the installation, call Agilent.OpenLab.CDSInstaller.exe with the 
following syntax: 

Agilent.OpenLab.CDSInstaller.exe -i ConfigurationXML="<path to xml 
file>" -q

For example:

Agilent.OpenLab.CDSInstaller.exe -i ConfigurationXML="c:\settings\
ConfigurationXML.xml" -q

With this command, you start the installation wizard without a user 
interface.

Preparations You must have copied all disks to a centralized folder (see “Step 2: Copy DVDs to a Network Share 
Folder for Installation (Optional)” on page 33). This step is mandatory for scripted installation.
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1 Right-click the executable of the command prompt or Power shell prompt, 
and run it as administrator.

You will get a return code for the scripted uninstallation only if you start it 
as administrator.

2 Navigate to the drive where you have saved the disks.

For example: C:\CDS_DVD

3 To start the uninstallation, call Agilent.OpenLab.CDSInstaller.exe with the 
following syntax:

Agilent.OpenLab.CDSInstaller.exe -u KeepComponents="<list of 
components>" -q

For Example:

Agilent.OpenLab.CDSInstaller.exe -u KeepComponents="IQT,IOLibraries" -q 

With the KeepComponents parameter, you can specify a list of shared 
components that you want to keep on the system (see “Parameters” on 
page 68). With the command given in the example, the OpenLAB CDS 
components Installation Qualification (IQT) and IO Library (IOLibraries) 
will be kept.
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Logging and Tracing

All exceptions, errors and information messages are logged in the following 
locations:

• During installation, upgrade, or repair: under <BaseInstallDirectory>\Logs

• During uninstallation: under <User's Temp>\<Company Name>\Logs\<Log 
folder>\<Wizard Name>.txt

Scripted Installation Report

You can see a report of the scripted installation result summary. This report is 
generated for installation, upgrade, repair, or uninstallation under 
<BaseInstallDirectory>\Logs\<Log folder>\<WizardName>.txt
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 This chapter includes information on how to use the Installation Qualification 
Tool, how to disable the Application Experience service, and how to configure 
the Advanced File Security (AFS). 
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Run the IQ After Software Installation

The installation qualification (IQ) provides documentary evidence that your 
system has been built and installed correctly, and that all design specifications 
have been met.

1 Using your Windows operating system, go to Start > All Programs > Agilent 
Technologies > Installation Qualification Tool.

2 Select Qualify.

The system will run the application and generate an Installation 
Qualification Report.

3 If the report indicates failure, verify the computer requirements and 
reinstall the data system.

Do not use the system until an Installation Qualification Report gives a 
‘pass’ result.
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Disable the Application Experience Service

It is highly recommended to disable the Application Experience service. 
Otherwise it can sporadically happen that the instrument session is closed 
during a reconnect and ChemStation is shut down unexpectedly. This can 
result in a data loss when acquisition is ongoing.

By default, the start type manual is selected for the Application Experience 
service. To ensure that it does not get started accidentally, set the start type to 
disabled.

1 Start Server Manager on the AIC.

2 Go to Server Manager > Configuration > Services.

3 Right-click Application Experience service.

4 Select Properties.

5 Set the start type to Disabled.

6 Click OK.
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Configure Advanced File Security (AFS)

Advanced file security is an optional configuration for OpenLAB CDS 
EZChrom Edition networked systems. It provides enhanced security on the 
enterprise path in order to prevent any unauthorized access to project data 
outside of the data system. This configuration sets the appropriate Windows 
sharing and security settings to allow only a defined group to access the 
enterprise data from Windows Explorer. This may only be configured if your 
system is configured to use Windows Domain as the Shared Services 
authentication provider.

Enable Advanced File Security

1 Prepare your system.

a Verify that your system is configured to use Windows Domain as the 
authentication provider. (See Configure Security and Storage > Set the 
authentication provider and the storage system in the online help.)

b Verify that your system is configured to use a storage path that is directly 
beneath the defined enterprise path.

c Create or define a Windows Domain group that will have access to the 
enterprise path outside of the data system.

d Define a minimum of two users who are members of the group defined 
above.

e Close all connections to the OpenLAB CDS system (i.e. clients, 
instrument runs, control panels).

f Obtain the login credentials of a domain user that has administrative 
rights to edit the enterprise path in its current state.

g Obtain the administrative login credentials of the OpenLAB Control 
Panel that were defined during the configuration of domain 
authentication.

2 On any OpenLAB CDS EZChrom Edition client, browse to the directory 
where the software was installed.

(by default: C:\Program Files\Agilent Technologies\EZChrom)
78 CDS Distributed System Installation Guide



Optional Procedures 7
Configure Advanced File Security (AFS)
3 Launch EnterpriseConfig.exe.

4 An Enterprise Setup Login dialog will display:

a In the OpenLAB Control Panel Login section enter the user name, password, 
and domain of the OpenLAB Control Panel Administrator.

b In the Windows User Information section enter the user name and password 
of the user with edit permission to the enterprise path.

• If this is a domain user account, select Logon from Windows Domain and 
enter the domain name (recommended).

• If this is a local PC account, select Windows Local PC. This may only be 
an account local to the machine where the EnterpriseConfig.exe program 
is being run.

c Click OK.

5 The system will process the above credentials. If they are valid, a warning 
will display to advise that once this process is completed, it cannot be 
reversed.

Click OK if you are prepared to proceed.

6 An Enterprise Service Account dialog will display:

a Enter the user name, password, and domain of a user defined to be a 
member of the AFS group.

b Enter the group name that will have access to the enterprise path under 
the restrictions of AFS.

c Click OK.
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This chapter describes the upgrade from different revisions to OpenLAB CDS 
A.01.04.
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Upgrade from Different Revisions

OpenLAB Shared Services Server and ChemStation machines

If you currently have a revision older than A.01.04 installed on the OpenLAB 
Shared Services server or on a ChemStation machine, the OpenLAB CDS Upgrade 
Wizard will upgrade the existing installation. You need to first upgrade the 
OpenLAB Shared Services server before upgrading the instrument controllers 
and CDS clients.

EZChrom machines

On EZChrom machines, OpenLAB CDS A.01.01 needs to be uninstalled before 
installing A.01.04. Upgrading from A.01.02 or higher does not require an 
uninstallation.
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Upgrade the OpenLAB Shared Services Server

To upgrade the OpenLAB Shared Services server to A.01.04, perform the 
following steps:

1 From the Master Installer Planning screen, switch to the Installation screen.

2 Select OpenLAB CDS Installation. As OpenLAB CDS is already installed, this 
automatically opens the OpenLAB CDS Upgrade Wizard.

3 In the Upgrade Type screen, select Next to proceed to the Summary screen.

4 In the Summary screen of the Upgrade Wizard, the components for the 
upgrade are listed. Select Start to start the upgrade.

If an error occurs during the upgrade, an error message appears. When a 
component is upgraded correctly, the status shown in the Status field 
changes from Installed to Successfully Upgraded.

5 After the upgrade is completed, a warning message appears, stating that 
you must restart Windows for some changes to take effect.

Select Yes to restart Windows.

Select No if you want to restart Windows at a later time.
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8 Upgrade to New Software Version
Upgrade the OpenLAB Shared Services Server
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About Troubleshooting
About Troubleshooting

The OpenLAB CDS Master Installer configures a Windows Server 2008 R2 
machine with the minimum footprint and effort, so its Remote Desktop 
Services functionality can be used to remotely control ChemStation 
instruments.

This comprises the creation of a number of local users required for launching 
the ChemStation instruments from a remote client. It also comprises 
configuring the machine as a Remote Desktop Services host and performing 
the registration tasks necessary to access and run ChemStation from a remote 
client.

Experience shows that there are numerous ways to restrict access to a server 
machine and local network so that the default installation will no longer work. 
This chapter is intended to list the known restrictions and provide means to 
get the AIC working even if there are several restrictions.

NOTE The following refers to ChemStation AIC only.
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Consider Before Installation

Network Level Authentication Required

Remote Desktop Services provides a higher level of security if the client's 
access is checked by the domain controller before actually accessing the AIC. 
Your IT department may require the use of this security level.

To switch an AIC to Network Level Authentication, perform the following 
steps:

1 Start Server Manager.

2 Select Roles > Remote Desktop Services > RD Session Host Configuration > 
RDPTCP Properties.

3 Under General, mark the check box Allow connections only from computers 
running Remote Desktop with Network Level Authentication.

4 Click OK.

Password Policy not Satisfied by Default Passwords

The local users created during installation by default have a password 
consisting of a random mixture of 3 uppercase letters, 3 lowercase letters, 3 
digits and 3 special characters. This should satisfy almost any password 
restriction rules.

To check if the user password matches the password restriction rules:

• Create a test user on the AIC.

• Set the test user's password to “uK0%wJ8+kA6+” for example.

NOTE Network Level Authentication is available for clients running Windows Vista and above. 
With KB951608, Microsoft provides a solution to enable Network Level Authentication on 
Windows XP SP 3. However, this solution does not work for an AIC client.
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If the password does not conform to the password rules:

• Create 9 compliant passwords and enter them during installation of the AIC 
(see section “Configure ChemStation Instrument Users Manually” on 
page 94 under Remedial Procedures).

Privilege “Allow Log-on Through Remote Desktop Services” not 
Granted for Remote Desktop Users Group by Group Policy

Some IT departments revoke the privilege Allow log-on through Remote 
Desktop Services from the Remote Desktop Users group (to which it is granted 
by default) by domain policy.

To check if the logon privilege is granted:

1 Select Start > Run...

2 Type secpol.msc.

3 Check the security setting for Local Policy > User Rights Assignment > Allow 
log-on through Remote Desktop Services. If the security setting does not include 
the Remote Desktop Users group:

a Negotiate with the local IT department to get an exception for this policy 
(preferred solution).

OR

Check if the logon privilege is granted to the Local Administrators group 
(workaround solution).

b If the privilege is granted: Set the unsafe=”true” switch during 
installation of the AIC (see “Configure ChemStation Instrument Users 
Manually” on page 94).

NOTE It is not possible to configure or launch ChemStation instruments remotely on this AIC if 
the instrument user does not have the described privilege.
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Not Possible to Launch the Instrument from the CDS Client

Make sure that the ChemStation installation folder is not shared. Doing so will 
disable launching the instrument from CDS client.

Remote Desktop Users Group is Emptied by Group Policy

Some IT departments empty the Remote Desktop Users group periodically by 
Group Policy.

To check if the Remote Desktop Users group is emptied:

1 Create a local test user.

2 Add the test user to the Remote Desktop Users.

3 Wait until the Group Policy application period has elapsed (in most cases 
within 24 hours).

4 Check in the Computer Management tool under Local Users and Groups > Groups 
> Remote Desktop Users if the test user is still present in this group. If the 
user is not present:

a Negotiate with the local IT department to get an exception for this policy 
(preferred solution).

OR

Check whether the security setting for Local Policy > User Rights 
Assignment > Allow log-on through Remote Desktop Services > > includes the 
Local Administrators group (workaround solution).

b If the security setting includes the Local Administrators group: Set the 
unsafe=”true” switch during installation of the AIC (see “Configure 
ChemStation Instrument Users Manually” on page 94). 

NOTE It is not possible to configure or launch ChemStation instruments remotely on this AIC if 
the instrument users do not have the described privilege.
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No Access to Domain Printers

Some IT departments allow the use of network printers only for domain users 
but not for local users.

1 Select Start > Devices and Printers.

2 Check the security properties of the printers set up on the AIC.

If the Local Users group or Remote Desktop Users group does not have Print 
privilege on the selected printer, do one of the following:

• Install and use a local printer (preferred solution, see below for 
instructions).

• Negotiate with the local IT department to get an exception for this 
security setting.

• Use domain users as instrument users:

• Create 11 domain users.

• Register the users and passwords during installation of the AIC (see 
“Register ChemStation Instrument Users with OpenLAB Shared 
Services” on page 97)

• Check whether the security setting includes the Local Administrators group 
(workaround solution).

If this is the case: Set the unsafe=”true” switch during installation of the 
AIC (see “Configure ChemStation Instrument Users Manually” on 
page 94).

NOTE This requires domain administrator privileges.

NOTE It is not possible to use the redirected printers that are installed on the client. These 
printers might become inaccessible when the instrument control is switched to a different 
client PC.
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Install a Local or Network Printer

1 Click Start > Devices and Printers.

2 Click tool button Add a Printer.

3 Click Add a local or network printer as administrator.

4 Click Add a local printer or Add a network, wireless or Bluetooth printer.

5 For network printers: Select Configure a new port, and in the drop-down box 
select Standard TCP/IP Port.

6 Click Next. Verify that the box Query the printer and automatically select the 
driver to use is checked.

7 Enter the hostname or IP address (use fully qualified name: e.g. <printer 
name>.germany.agilent.com). The port name is displayed identically.

8 Click Next. Windows will communicate with the printer and install the 
driver if required. Then select Use this driver that is currently installed 
(recommended) (default). Optionally it can be replaced.

9 Click Next. Use the default displayed printer name or change it to a suitable 
expression if required.

10 Click Next. The printer will be installed.

11 After installation, verify that the radio button Do not share this printer is 
selected.

12 Click Next. Check the box Set as the default printer if required. Print a test 
page.

13 Click Finish when test page is successfully printed.
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Consider After Installation

Error Message “Your Credentials did not Work” when Configuring 
or Launching an Instrument

After selecting the Configure Instrument or Launch button in the OpenLAB 
Configuration Panel an error message appears, stating that the logon to the AIC 
failed.

1 Log on by selecting Use another account.

2 Type in the user name and password from the retained users.xml file (see 
“Configure ChemStation Instrument Users Manually” on page 94).

If this logon attempt succeeds, the logon information registered on the 
OpenLAB Shared Services server for this AIC is corrupt.

3 Re-register the users.xml file as described in “Register ChemStation 
Instrument Users with OpenLAB Shared Services” on page 97.

4 Check if the ChemStation instrument user still has the necessary access 
rights (see “Configure ChemStation Instrument Users Manually” on page 94 
and “Remote Desktop Users Group is Emptied by Group Policy” on 
page 89):

a Apply the remedy or workaround as described in the sections mentioned 
above.

b On the AIC check if this account is locked out, using the Computer 
Management tool under Local Users and Groups > Users.

c Uncheck the box Account is disabled.
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Error Message “Program Execution Failed” when Configuring or 
Launching an Instrument

After selecting the Configure Instrument or Launch button in the OpenLAB 
Configuration Panel an error message appears, stating that program execution 
failed.

1 On the AIC, start Server Manager. Select Roles > Remote Desktop Services > 
RemoteApp Manager Properties.

2 Check that the RemoteApp Programs list SetupWizardLauncher with the 
attribute Unrestricted in column Arguments.

3 On the AIC, start Windows Explorer and check that the instrument users or 
Local Users group or Remote Desktop Users group have read/write and execute 
access to the ChemStation installation directory.

Login Delay

If you are experiencing high response times during logon to the system or 
reconnecting after a session lock, the following causes might apply:

• DNS not set up correctly.

Check that the name resolution is working properly for all affected 
computers.

• Ports blocked by firewall.

Check that the ports listed in OpenLAB CDS Network Requirements are not 
blocked by your firewall.
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Configure ChemStation Instrument Users Manually

During installation of OpenLAB CDS, the instrument users names and 
passwords can be configured by an XML file.

The default XML file has the following structure: 

<xml version="1.0" encoding="utf-8">

<users>

<user UserName="CSIUser0" />

<user UserName="CSIUser1" />

<user UserName="CSIUser2" />

<user UserName="CSIUser3" />

<user UserName="CSIUser4" />

<user UserName="CSIUser5" />

<user UserName="CSIUser6" />

<user UserName="CSIUser7" />

<user UserName="CSIUser8" />

<user UserName="CSIUser9" />

<user UserName="CSIUser10" />

</users>
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OpenLAB CDS Master Installer fills the structure with the created passwords 
and the machine-prefixed user names: 

<?xml version="1.0" encoding="utf-8" ?>

<users>

<user UserName="wwadpl03\CSIUser0" Password="aZ1=kE4$nP8#" />

<user UserName="wwadpl03\CSIUser1" Password="hM6%cB2!kE4#" />

<user UserName="wwadpl03\CSIUser2" Password="yU7&lF9$oG6(" />

<user UserName="wwadpl03\CSIUser3" Password="rS3=bC3!jE4)" />

<user UserName="wwadpl03\CSIUser4" Password="xS8%vM8=qX0)" />

<user UserName="wwadpl03\CSIUser5" Password="nW9%uM7!xZ7^" />

<user UserName="wwadpl03\CSIUser6" Password="uK0%wJ8+kA6+" />

<user UserName="wwadpl03\CSIUser7" Password="lM5!mT9+vQ3#" />

<user UserName="wwadpl03\CSIUser8" Password="gZ2[nJ8[aL6&" />

<user UserName="wwadpl03\CSIUser9" Password="rT8%vM9-qX0" />

<user UserName="wwadpl03\CSIUser10" Password="hM6%cY1!kE5#" />

</users>

Please retain this file in a safe location for later troubleshooting.
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Configure ChemStation Instrument Users Manually

OpenLAB CDS Master Installer offers the option to specify different user 
names or passwords during the installation of an AIC. When using domain 
users, it might become necessary to change their passwords on a regular basis.

1 Specify different user names or passwords:

a Provide domain users in the form: UserName="<domain name>\<user 
name>".

b Provide special passwords in the form: Password="<user defined 
password>”.

c Enforce addition of users to the Local Administrators group by setting 
the users attribute: 
<users unsafe="true”>

2 Change domain user passwords:

a Press Ctrl-Alt-Del and select Change a Password (Change Password... on 
Windows XP).

b Enter <domain>\<user name> in the User name box, together with the old 
password and new password (2 times) in the respective boxes.

c Repeat step 2b for each instrument user.

d Copy the passwords to the users.xml file (make sure the passwords 
comply with the domain policy for passwords).

e Register the new passwords with OpenLAB Shared Services as described 
in section “Register ChemStation Instrument Users with OpenLAB 
Shared Services” on page 97.

f Restart OpenLAB Control Panel before launching the reconfigured 
instruments.

NOTE Make sure that at least 11 different user names are provided. If you provide the same 
username twice, instrument access conflicts will arise.
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Register ChemStation Instrument Users with OpenLAB Shared 
Services

To re-register the retained, if necessary edited, users.xml file perform the 
following steps:

1 On the AIC, select Start > Command Prompt.

2 Type cd <ChemStation installation directory>\Core and press Enter.

3 Type registerCSData.exe /remote /InstrumentUsers=<Path to users.xml 
file> /url=net.tcp://<OpenLAB Shared Services 
server>:6577/Agilent/OpenLAB/ /user:<name of OpenLAB Shared Services 
admin user> /password:<password of OpenLAB Shared Services admin 
user> and press Enter.
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This chapter contains additional information on Microsoft SQL Server 2008 R2.
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Change Server Authentication to Mixed Mode

This procedure desribes how you can switch to Mixed Mode in an existing 
Microsoft SQL Server 2008 R2 installation.

1 Start SQL Server Management Studio.

2 In the Object Explorer, right-click the server name, and select Properties 
from the context menu.

3 In the Server Properties dialog, select the Security page.

4 Under Server authentication, select SQL Server and Windows Authentication mode.

5 Click OK.

6 Enable login for user sa.

a In the Object Explorer, navigate to Security > Logins.

b Right-click the user sa, and select Properties from the context menu.

c In the Login Properties dialog, select the General page.

d Provide a strong password.

e Select the Status page.

f Under Login, select Enabled.

Click OK.

7 Restart the SQL Server service, and log in with SQL Server Authentication.
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